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	Create a new document
	CTRL+N

	Open a document
	CTRL+O

	Close a document
	CTRL+W

	Split a document
	ALT+CTRL+S

	Save a document
	CTRL+S

	Quit Word
	ALT+F4

	Find text, formatting, and special items
	CTRL+F

	Repeat find
	ALT+CTRL+Y

	Replace text, specific formatting, and special items
	CTRL+H

	Go to a page, bookmark, footnote, table, comment, graphic, or other location
	CTRL+G

	Go back to a page, bookmark, footnote, table, comment, graphic, or other location
	ALT+CTRL+Z

	Browse a document
	ALT+CTRL+HOME

	Cancel an action
	ESC

	Undo an action
	CTRL+Z

	Redo or repeat an action
	CTRL+Y

	Switch to page layout view
	ALT+CTRL+P

	Switch to outline view
	ALT+CTRL+O

	Switch to normal view
	ALT+CTRL+N

	Move between a master document and its subdocuments
	CTRL+\
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Table 1: Function keys in Microsoft Word
	Function key
	
	SHIFT
	CTRL
	CTRL+SHIFT
	ALT
	ALT+SHIFT

	F1
	Display Help 
	Context sensitive Help or reveal formatting
	
	Go to next field
	Go to previous field
	Display Microsoft System Information

	F2
	Move text or graphics
	Copy text
	Print Preview 
	
	Save 
	Open

	F3
	Insert an AutoText entry
	Change the case of letters
	Cut to the Spike
	Insert the contents of the Spike
	Create an AutoText entry
	

	F4
	Repeat the last action
	Repeat a Find or Go To action
	Close the window
	
	Quit Word
	Quit Word

	F5
	 Go To command (Edit menu)
	Move to a previous revision
	Restore the document window size
	Edit a bookmark
	Restore the program window size
	

	F6
	Go to next pane
	Go to the previous pane
	Go to the next window
	Go to the previous window
	
	

	F7
	Spelling command 
	Thesaurus command 
	Move
	Update Links
	Find next misspelling 
	

	F8
	Extend a selection
	Shrink a selection
	Size command 
	Extend a selection
	Run a macro
	

	F9
	Update selected fields
	Switch between a field code and its result
	Insert an empty field
	Unlink a field
	Switch between all field codes and their results
	Run GOTOBUTTON or MACROBUTTON 

	F10
	Activate the menu bar
	Display a shortcut menu
	Maximize the document 
	Activate the ruler
	Maximize the program window
	

	F11
	Go to the next field
	Go to the previous field
	Lock a field
	Unlock a field
	Display Visual Basic code
	

	F12
	Save As 
	Save 
	Open 
	Print 
	
	





[bookmark: _Toc150657822][bookmark: _Toc150679336][bookmark: _Toc177357654][bookmark: _Toc177358208]Keys for formatting characters and paragraphs

Format characters 

	Change the font
	CTRL+SHIFT+F

	Change the font size
	CTRL+SHIFT+P

	Increase the font size
	CTRL+SHIFT+>

	Decrease the font size
	CTRL+SHIFT+<

	Increase the font size by 1 point
	CTRL+]

	Decrease the font size by 1 point
	CTRL+[

	Change the formatting of characters (Font command, Format menu)
	CTRL+D

	Change the case of letters
	SHIFT+F3

	Format letters as all capitals 
	CTRL+SHIFT+A

	Apply bold formatting
	CTRL+B

	Apply an underline 
	CTRL+U

	Underline words but not spaces
	CTRL+SHIFT+W

	Double-underline text
	CTRL+SHIFT+D

	Apply hidden text formatting
	CTRL+SHIFT+H

	Apply italic formatting
	CTRL+I

	Format letters as small capitals 
	CTRL+SHIFT+K

	Apply subscript formatting (automatic spacing)
	CTRL+EQUAL SIGN

	Apply superscript formatting (automatic spacing)
	CTRL+SHIFT+PLUS SIGN

	Remove manual character formatting
	CTRL+SPACEBAR

	Change the selection to Symbol font
	CTRL+SHIFT+Q

	Display nonprinting characters
	CTRL+SHIFT+* (asterisk)

	Review text formatting 
	SHIFT+F1 (then click the text whose formatting you want to review)

	Copy formats
	CTRL+SHIFT+C

	Paste formats
	CTRL+SHIFT+V



Format paragraphs 

	Single-space lines
	CTRL+1

	Double-space lines
	CTRL+2

	Set 1.5-line spacing
	CTRL+5

	Add or remove one line space preceding a paragraph
	CTRL+0 (zero)

	Centre a paragraph
	CTRL+E

	Justify a paragraph
	CTRL+J

	Left align a paragraph
	CTRL+L

	Right align a paragraph
	CTRL+R

	Indent a paragraph from the left
	CTRL+M

	Remove a paragraph indent from the left
	CTRL+SHIFT+M

	Create a hanging indent
	CTRL+T

	Reduce a hanging indent
	CTRL+SHIFT+T

	Remove paragraph formatting
	CTRL+Q

	When applying styles, to
	Press

	Apply a style 
	CTRL+SHIFT+S

	Start AutoFormat
	ALT+CTRL+K

	Apply the Normal style
	CTRL+SHIFT+N

	Apply the Heading 1 style
	ALT+CTRL+1

	Apply the Heading 2 style
	ALT+CTRL+2

	Apply the Heading 3 style
	ALT+CTRL+3

	Apply the List style
	CTRL+SHIFT+L
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Delete text and graphics 

	Delete one character to the left
	BACKSPACE

	Delete one word to the left 
	CTRL+BACKSPACE

	Delete one character to the right 
	DELETE

	Delete one word to the right 
	CTRL+DELETE

	Cut selected text to the Clipboard
	CTRL+X

	Undo the last action
	CTRL+Z 

	Cut to the Spike
	CTRL+F3





Copy and move text and graphics 

	Copy text or graphics
	CTRL+C

	Move text or graphics
	F2 (then move the insertion point and press ENTER)

	Create AutoText
	ALT+F3

	Paste the Clipboard contents 
	CTRL+V

	Paste the Spike contents
	CTRL+SHIFT+F3



Insert special characters

	A field
	CTRL+F9

	An AutoText entry
	ENTER (after typing the first few characters of the AutoText entry name and when the ScreenTip appears)

	A line break
	SHIFT+ENTER

	A page break
	CTRL+ENTER

	A column break
	CTRL+SHIFT+ENTER

	An optional hyphen
	CTRL+HYPHEN

	A nonbreaking hyphen
	CTRL+SHIFT+HYPHEN

	A nonbreaking space
	CTRL+SHIFT+SPACEBAR

	The copyright symbol
	ALT+CTRL+C

	The registered trademark symbol
	ALT+CTRL+R

	The trademark symbol
	ALT+CTRL+T

	An ellipsis
	ALT+CTRL+period



Select text and graphics

	One character to the right
	SHIFT+RIGHT ARROW

	One character to the left
	SHIFT+LEFT ARROW

	To the end of a word
	CTRL+SHIFT+RIGHT ARROW

	To the beginning of a word
	CTRL+SHIFT+LEFT ARROW

	To the end of a line
	SHIFT+END

	To the beginning of a line
	SHIFT+HOME

	One line down
	SHIFT+DOWN ARROW

	One line up
	SHIFT+UP ARROW

	To the end of a paragraph
	CTRL+SHIFT+DOWN ARROW

	To the beginning of a paragraph
	CTRL+SHIFT+UP ARROW

	One screen down
	SHIFT+PAGE DOWN

	One screen up
	SHIFT+PAGE UP

	To the end of a window
	ALT+CTRL+PAGE DOWN

	To the beginning of a document
	CTRL+SHIFT+HOME

	To include the entire document
	CTRL+A

	To a vertical block of text
	CTRL+SHIFT+F8, and then use the arrow keys; press ESC to cancel selection mode

	To a specific location in a document
	F8+arrow keys; press ESC to cancel selection mode



Tip   If you know the key combination to move the insertion point, you can select the text by using the same key combination while holding down SHIFT. For example, CTRL+RIGHT ARROW moves the insertion point to the next word, and CTRL+SHIFT+RIGHT ARROW selects the text from the insertion point to the beginning of the next word.

Select text and graphics in a table 

	Select the next cell's contents
	TAB

	Select the preceding cell's contents
	SHIFT+TAB

	Extend a selection to adjacent cells
	Hold down SHIFT and press an arrow key repeatedly

	Select a column
	Click in the column's top or bottom cell. Hold down SHIFT and press the UP ARROW or DOWN ARROW key repeatedly

	Extend a selection (or block)
	CTRL+SHIFT+F8, and then use the arrow keys; press ESC to cancel selection mode

	Reduce the selection size
	SHIFT+F8

	Select an entire table
	ALT+5 on the numeric keypad (with NUM LOCK off)



Extend a selection 

	Turn extend mode on
	F8

	Select the nearest character
	F8, and then press LEFT ARROW or RIGHT ARROW

	Increase the size of a selection
	F8 (press once to select a word, twice to select a sentence, and so forth)

	Reduce the size of a selection
	SHIFT+F8

	Turn extend mode off
	ESC



Move the insertion point 

	One character to the left
	LEFT ARROW

	One character to the right
	RIGHT ARROW

	One word to the left
	CTRL+LEFT ARROW

	One word to the right
	CTRL+RIGHT ARROW

	One paragraph up
	CTRL+UP ARROW

	One paragraph down
	CTRL+DOWN ARROW

	One cell to the left (in a table)
	SHIFT+TAB

	One cell to the right (in a table)
	TAB

	Up one line
	UP ARROW

	Down one line
	DOWN ARROW

	To the end of a line
	END

	To the beginning of a line
	HOME

	To the top of the window
	ALT+CTRL+PAGE UP

	To the end of the window
	ALT+CTRL+PAGE DOWN

	Up one screen (scrolling)
	PAGE UP

	Down one screen (scrolling)
	PAGE DOWN

	To the top of the next page
	CTRL+PAGE DOWN

	To the top of the previous page
	CTRL+PAGE UP

	To the end of a document
	CTRL+END

	To the beginning of a document
	CTRL+HOME

	To a previous revision
	SHIFT+F5

	To the location of the insertion point when the document was last closed
	SHIFT+F5




Move around in a table 

	Next cell in a row
	TAB

	Previous cell in a row
	SHIFT+TAB

	First cell in a row
	ALT+HOME

	Last cell in a row
	ALT+END

	First cell in a column
	ALT+PAGE UP

	Last cell in a column
	ALT+PAGE DOWN

	Previous row
	UP ARROW

	Next row
	DOWN ARROW



Insert paragraphs and tab characters in a table 

	New paragraphs in a cell
	ENTER

	Tab characters in a cell
	CTRL+TAB
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	Insert a comment
	ALT+CTRL+M

	Turn revision marks on or off
	CTRL+SHIFT+E

	Go to the beginning of a comment
	CTRL+HOME

	Go to the end of a comment
	CTRL+END



[bookmark: _Toc150657825][bookmark: _Toc150679339][bookmark: _Toc177357657][bookmark: _Toc177358211]Keys for performing a mail merge

	Preview a mail merge
	ALT+SHIFT+K

	Merge a document
	ALT+SHIFT+N

	Print the merged document
	ALT+SHIFT+M

	Edit a mail-merge data document
	ALT+SHIFT+E

	Insert a merge field
	ALT+SHIFT+F
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	Print a document
	CTRL+P

	Switch to Print Preview
	ALT+CTRL+I

	Move around the preview page when zoomed in
	Arrow keys

	Move by one preview page when zoomed out
	PAGE UP or PAGE DOWN

	Move to the first preview page when zoomed out
	CTRL+HOME

	Move to the last preview page when zoomed out
	CTRL+END
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	A DATE field
	ALT+SHIFT+D

	A LISTNUM field
	ALT+CTRL+L

	A PAGE field
	ALT+SHIFT+P

	A TIME field
	ALT+SHIFT+T

	An empty field
	CTRL+F9

	Update linked information in a Word source document
	CTRL+SHIFT+F7

	Update selected fields
	F9

	Unlink a field
	CTRL+SHIFT+F9

	Switch between a field code and its result
	SHIFT+F9

	Switch between all field codes and their results
	ALT+F9

	Run a GOTOBUTTON or MACROBUTTON from the field that displays the field results 
	ALT+SHIFT+F9

	Go to the next field
	F11

	Go to the previous field
	SHIFT+F11

	Lock a field
	CTRL+F11

	Unlock a field
	CTRL+SHIFT+F11
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	Promote a paragraph
	ALT+SHIFT+LEFT ARROW

	Demote a paragraph
	ALT+SHIFT+RIGHT ARROW

	Demote to body text
	CTRL+SHIFT+N

	Move selected paragraphs up
	ALT+SHIFT+UP ARROW

	Move selected paragraphs down
	ALT+SHIFT+DOWN ARROW

	Expand text under a heading
	ALT+SHIFT+PLUS SIGN

	Collapse text under a heading
	ALT+SHIFT+MINUS SIGN

	Expand or collapse all text or headings
	ALT+SHIFT+A or the asterisk (*) key on the numeric keypad

	Hide or display character formatting
	The slash (/) key on the numeric keypad

	Show the first line of body text or all body text
	ALT+SHIFT+L

	Show all headings with the Heading 1 style
	ALT+SHIFT+1

	Show all headings up to Heading n
	ALT+SHIFT+n
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	Show the shortcut menu
	SHIFT+F10

	Make the menu bar active
	F10

	Show the program icon menu (on the program title bar)
	ALT+SPACEBAR

	Select the next or previous command on the menu or submenu 
	DOWN ARROW or UP ARROW (with the menu or submenu displayed)

	Select the menu to the left or right; or, with a submenu visible, switch between the main menu and the submenu
	LEFT ARROW or RIGHT ARROW

	Select the first or last command on the menu or submenu
	HOME or END

	Close the visible menu and submenu at the same time
	ALT

	Close the visible menu; or, with a submenu visible, close the submenu only
	ESC



Tip   You can select any menu command on the menu bar or on a visible toolbar with the keyboard. Press ALT to select the menu bar. (To then select a toolbar, press CTRL+TAB; repeat until the toolbar you want is selected.) Press the letter that is underlined in the menu name that contains the command you want. In the menu that appears, press the letter underlined in the command name that you want.
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	Make the menu bar active
	F10

	Select the next or previous toolbar
	CTRL+TAB or CTRL+SHIFT+TAB

	Select the next or previous button or menu on the toolbar
	TAB or SHIFT+TAB (when a toolbar is active)

	Open the menu
	ENTER (when a menu on a toolbar is selected)

	Perform the action assigned to a button 
	ENTER (when a button is selected)

	Enter text in a text box
	ENTER (when the text box is selected)

	Select an option from a drop-down list box or from a drop-down menu on a button
	Arrow keys to move through options in the list or menu; ENTER to select the option you want (when a drop-down list box is selected)
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	Switch to the next program
	ALT+TAB

	Switch to the previous program
	ALT+SHIFT+TAB

	Show the Windows Start menu
	CTRL+ESC

	Close the active document window
	CTRL+W

	Restore the active document window 
	CTRL+F5

	Switch to the next document window
	CTRL+F6

	Switch to the previous document window 
	CTRL+SHIFT+F6

	Carry out the Move command (document icon menu, menu bar)
	CTRL+F7

	Carry out the Size command (document icon menu, menu bar)
	CTRL+F8

	Minimize the document window
	CTRL+F9

	Maximize the document window
	CTRL+F10

	Select a folder in the Open or Save As dialog box (File menu)
	ALT+0 to select the folder list; arrow keys to select a folder

	Choose a toolbar button in the Open or Save As dialog box (File menu)
	ALT+ number (1 is the leftmost button, 2 is the next, and so on)

	Update the files visible in the Open or Save As dialog box (File menu)
	F5

	In a dialog box, to
	Press

	Switch to the next tab in a dialog box
	CTRL+TAB or CTRL+PAGE DOWN

	Switch to the previous tab in a dialog box
	CTRL+SHIFT+TAB or CTRL+PAGE UP

	Move to the next option or option group
	TAB

	Move to the previous option or option group
	SHIFT+TAB

	Move between options in the selected drop-down list box or between some options in a group of options 
	Arrow keys

	Perform the action assigned to the selected button; select or clear the check box
	SPACEBAR

	Move to the option by the first letter in the option name in a drop-down list box
	Letter key for the first letter in the option name you want (when a drop-down list box is selected)

	Select the option or select or clear the check box by the letter underlined in the option name
	ALT+ letter key

	Open a drop-down list box
	ALT+DOWN ARROW (when a drop-down list box is selected)

	Close a drop-down list box
	ESC (when a drop-down list box is selected)

	Perform the action assigned to the default button in the dialog box
	ENTER

	Cancel the command and close the dialog box
	ESC

	In a text box, to
	Press

	Move to the beginning of the entry
	HOME

	Move to the end of the entry
	END

	Move one character to the left or right
	LEFT ARROW or RIGHT ARROW

	Move one word to the left or right
	CTRL+LEFT ARROW or CTRL+RIGHT ARROW

	Select from the insertion point to the beginning of the entry
	SHIFT+HOME

	Select from the insertion point to the end of the entry
	SHIFT+END

	Select or unselect one character to the left
	SHIFT+LEFT ARROW

	Select or unselect one character to the right 
	SHIFT+RIGHT ARROW

	Select or unselect one word to the left
	CTRL+SHIFT+LEFT ARROW

	Select or unselect one word to the right
	CTRL+SHIFT+RIGHT ARROW
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	Insert a hyperlink
	CTRL+K

	Go back one page
	ALT+LEFT ARROW

	Go forward one page
	ALT+RIGHT ARROW

	Refresh
	F9
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	Mark a table of contents entry
	ALT+SHIFT+O

	Mark a table of authorities entry
	ALT+SHIFT+I

	Mark an index entry
	ALT+SHIFT+X

	Insert a footnote
	ALT+CTRL+F

	Insert an endnote
	ALT+CTRL+E
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	Make the Office Assistant balloon active
	ALT+F6

	Select a Help topic from the topics the Office Assistant displays
	ALT+number (1 is the first topic, 2 is the second, and so on)

	Select a Help topic from the topics the Office Assistant shows
	ALT+ number (1 is the first topic, 2 is the second, and so on)

	See more Help topics
	ALT+DOWN ARROW

	See previous Help topics
	ALT+UP ARROW

	Close an Office Assistant message
	ESC

	Get Help from the Office Assistant
	F1

	Display the next tip
	ALT+N

	Display the previous tip
	ALT+B

	Close tips
	ESC

	Show or hide the Office Assistant in a wizard
	TAB to select the Office Assistant button; SPACEBAR to show the Assistant or turn off Help with the wizard





On the Insert tab, the galleries include items that are designed to coordinate with the overall look of your document. You can use these galleries to insert tables, headers, footers, lists, cover pages, and other document building blocks. When you create pictures, charts, or diagrams, they also coordinate with your current document look.
You can easily change the formatting of selected text in the document text by choosing a look for the selected text from the Quick Styles gallery on the Home tab. You can also format text directly by using the other controls on the Home tab. Most controls offer a choice of using the look from the current theme or using a format that you specify directly.
Extend a selection 

	Turn extend mode on
	F8

	Select the nearest character
	F8, and then press LEFT ARROW or RIGHT ARROW

	Increase the size of a selection
	F8 (press once to select a word, twice for a sentence, thrice for a paragraph)

	Reduce the size of a selection
	SHIFT+F8

	Turn extend mode off
	ESC



To change the overall look of your document, choose new Theme elements on the Page Layout tab. To change the looks available in the Quick Style gallery, use the Change Current Quick Style Set command. Both the Themes gallery and the Quick Styles gallery provide reset commands so that you can always restore the look of your document to the original contained in your current template.
On the Insert tab, the galleries include items that are designed to coordinate with the overall look of your document. You can use these galleries to insert tables, headers, footers, lists, cover pages, and other document building blocks. When you create pictures, charts, or diagrams, they also coordinate with your current document look.
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